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\lmporta nt safety instructions
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CAUTION: to reduce the risk of electric shock do not
remove cover (or back), No user-senviceable parts
inside. Refer servicing to qualified service personnel

The lightning flash with arowhead symbol,

within an equilateral triangle, is intended

o alert the user o the presence of an
: un-insulated "dangerous voltage” within the
product's enclosure that may be of sufficient magnitude
to constitute a risk of electric shock 1o persons

The exclamation mark within an equilateral

riangle 15 intended to alert the user o

the presence of impaortant operating and

maintenance (servicing) instructions in the
literature accompanying the equipment.

Instructions

Before installing or operating the equipment read all
safety instructions, warnings and operating instructions.
Heed all warnings. Follow all instructions. Keep all safety,
installation and cperating instructions for future reference.

Installing and operation location

Do not use this apparatus near water, Do ot expose this
apparatus to drips or splashes. Do not place any objects
filled with liquids, such as vases, on the apparatus.

Do not install near any heat sources such as radiators,
heat registers, stoves, or other apparatus (including
amplifiers) that produce heat. No naked flames, such as
lighted candles, should be placed on the apparatus.

Do not install the apparatus in a confined space such as
a book case or similar unit, Do not block any ventilation

openings.

Ensure thatfereign objects and liquidscannatget intc the
equipment

Install in accordance with the manufacturers instructi-
ons. Only use attachments/accessories specified by the
manufacturer,

Use only with the cart, stand, tripod, bracket or table
specified by the manufacturer, or sold with the apparatus.
When a cart is used, use caution when moving the cart/
apparatus combination to avaid injury from tip-aver .

The apparatus should be located close
enough to the AC outlet so that you can
easily grasp the power cord plug at any
fime

The maing plug, the appliance coupler or the mains

~

switch is used as the disconnect device. Either devicy
shall remain readily operable when the apparatusisinstal
led or used.

This product should be operated only from the powe
source indicated on the apparatus or in the operating
instructicns. If you are not sure of the type of power suppl
to the premises wherg the eguipment I8 10 be used
consult your product dealer or local power company.

Do not defeat the safety purpose of the polarised o
grounding-type plug. A polarised plug has two bladeg
with one wider than the other. A grounding type plug hag
two blades and a third grounding prong. The wide blads
or the third prong is provided foryour safety. If the provided
plug does not At into your outlet, consult an electrician fol
replacement of the obsolete autlet

Connect Class | construction apparatus o an AC outle
with a protective grounding connection,

Do not overload wall cutlets, extension cords or integra
convenience receptacles as this can result in a risk of firg
or electric shock.

Protect the power cord from being walked on or pinched
particularly at plugs, convenience receptacles and the
point where they exit from the apparatus.

Unplug this apparatus durng lightning storms or when
unused for long periods of time.
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y
_ your local waste administration, waste collection )

company or dealer.
Unplug the apparatus from the wall outlet before

cleaning. Donotuse liguidcleaners oraerosol cleaners,
Use a damp cloth for cleaning.

Do not attempt 1© service this product yourself, as

Opening or removing covers may expose you o (D
dangerous voltage or other hazards. Refer all servicing %@
to qualified service personal

Servicing Is required when the apparatus has been
damaged in any way, such as powersupply cord or
plug damaged, liguid has been spilled or cbjects have
falleninto the apparatus, the apparatus has been expo-
sed to rain or moisture, does not operate normally or
has been dropped.

The eguipment may only be used for the purpose
described in the operation instructions. Never carny out
any work on the equipment other than as specified in
the operating manual

Never pushoblects of any kind into this product through
openings. as they may touch dangerous voltage points
or short-cut parts, which could resultin a fire or electric
shock.

Children should never use the apparatus without close
adult supervision.

WARNING: excessive sound pressure levels can cause
hearing loss,

Electrical and electronic equipment may contain hazar-
dous substances for humans and their environment,

The ‘crossed out wheelie bin' symbol
present on the device and represented
above s there to remind one of the cbligation
of selective collection of waste. This [akel is
EE ooplied to various products to indicate that
the product is not o be thrown away as
unsorted municipal waste. Atthe end of life, dispose of
this product by returning it to the point of sale or toyour
local municipal collection point for recyeling of electric
and electronic devices.
Customer participation is important to minimize the
potential affects on the environment and human health
that can result from hazardous substances that may be
contained in this product
Please, dispose of this product and its packaging in
accordance withlocal and national disposal regulations
including those gaverning the recovery and recycling
of waste electrical and electronic equipment Contact
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Introduction

Dear customer,

Thank you for buying the Apex Inteli-Power10 The Intell-Powsr 10 is a professional quality, DSP-based system
management processor with an integrated 4-channel amplifier. It provides all the equalisation, crossover filtering,
time alignment and limiting required by the current generation of high performance loudspeaker systems.

+ 44in, 4-out with analog, AES3 and optional Dante con-

nectivity

- LCD display with intuitive menu system

- Noexternal computer necessary

- Inputs and outputs selectable as analogue or digital in

pairs

- User-selectable analogue input sensitivities and output

levels

- Sample Rate Conversion available on digital inputs

+ Automatic redundant clock source selection with

definable hierarchy

+ Internal sample rates available from 441 kHz to 192

kHz

+ Anyinput can be assigned to any cutputto create one

or more crossovers of various configurations

- Input channel DSP facilities:
- Gain adjustment and phase inversion

- Delay (15 s max.), definable as time ordistance,
with temperature and RH compensation

- 30-band ISO-centred graphic equalisation

- 12-band parametric filtering, with chaice of 16 filter
types
+ Compressor

- Outputchannel DSPfaciliies
- Delay (15 s max), definable as time ordistance,
with temperature and RH compensation

- Driver alignment delay (30 ms max), definable as
time or distance

- 12-band parametric filtering, with choice of 16 filter
types

- High- and low-pass crossover filtering with choice
of filter types

+ FIR/IR filtier implementation

+ Peak/RMS limiter

+ Internal preset library

- Eventlogging system

- Ethemet rermote control using Intelli-Ware PC applica-

fion; static IP, DHCP and aute-IP compatible; wired or

wireless

- Fourclass D, DC coupled driven from DAC B0Hz burst

rms 1/3 12dB crest factor amplifiers (4x 2500w, 2ohm

4x 2500w, 40hm 4x 1600w, 8ohm )

+ Apex Direct Drive technology

- High reliability PSU with PowerCON® connector

+ Professional quality XLR and EtherCON® connectors

throughout

+ 2U18" rack-rounting unit

&

Foreword

Featuring dual DSP intemal processing, high-end studio-
grade analogue circult de-signs, the new Intelli-Power 10 sets
the new benchmark in powered system manage-ment and
speaker processing design. The D/A conversion features
DirectDive technol-ogy which enhiances the impuls response
for accurate bass response,

Whether the application is for a standalone system amplifi er
confi gured using front panel controls, or a compre-hensive
wirsless networked system for Stadium or Arena sized tours,
the Intelli-Power 10 is designed to provide the solution that our
clients demand. With comprehen-sive loudspesker preset
ca-pability, implementing the Intelli-series into your system
couldn't be easier.

The crossover characteristics (usually supplied by the
manufacturer of the loudspeakers being used) can be quickly
and easily entered into the Intelli-Power10 and then stored in
the: unit for later recall This is of great advantage with touring
systems, where the configuration of the speaker rig necessarily
changes from venus to venus,

The Intli-Power10 remote control capabiliies allow fing
tuning of the sound system 1o be carried out from a remote
PC, typically a wireless-enabled tablet PC
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About this manual

Carefully read all instructions and wamings before ope-
rating this appliance. Keep this manual in a safe place so
that it can be referred to when required.

The latest manual revision can be downloaded from the
download section of the Apex website;
hitp/Avww.apex-audio.eu

This manual describes use of Intelli-Power10 fitted with
firmware version v2.4.1.0

Inspection and unpacking

This appliance has been carefully packed in the fac-
tory and the packaging was designed to withstand
rough handling. Should the unit appear to have been
damaged in transit, do not discard any of the packing
material and notify the carrier immediately as they will be
responsible.

Save all the packing materials for future use if you ever
need to ship the unit again.

Please check the list below against the contents of the
packaging. If any items are missing ordamaged, contact
the Apex dealer or distributor where you purchased the
unit.

- Intelli-Power10 amplifier

- AC power cables with Neutrik PowerCON® con-
nector

- Network cable ("straight” type)

- USB with Intelli-Ware software and other product
documentation

- This manual

Before you get started

Operating environment

This appliance is designed to operate in most normal climates,
at a temperature between 0 °C and 50 °C (32 - 122 °F), with
relative humidity between 10% and 80%,

The Inteli-Power10incorporates aninternal fan-cocling, which
should keep the unit within its operating temperature range in
maost situations. However, should the unit be installed in an
equipment rack it is important to ensure that the iemperature
inside the rack does not exceed the upper limit. This could be
the case when the rack contains power amplifiers. Under such
circumstances, additional rack-mountad cooling fans may be
necessary.

Power requirements

BEFORE you connect any unit to the mains, please make surg
that the voltage of your local AC supply is within the accepta-
ble range of the unit,

The Inteli-Power10 1s designed to work from an AC supply
between 100V and 240V, at a frequency between 50 and 60
Hz. No AC voltage selector is provided as the device automati-
cally adjusts tc the incaming AC voltage.

Precautions should be taken so that the appliance is properly
groundsd at all times. This unit must be earthed

Installation

If the unit is brought Into a warm room from a cold environ-
ment, internal condensation may occur. Ensure that the unit
has been allowed to reach ambient temperature before swit-
chingiton.

Although this unit is intended for installation in a standard
19-nch rack it can nevertheless be used freestanding. If the
unitis installed in a flight-case or in an equipment rack, fix the
unit with all four screws through the front panel holes.and
the four screws from the backpanel. For normal use no extra
supportis needed, butin more extreme conditions, such ason
the road, we recommend the unit is supported at the rear.

The Intelli-Powsr 10is fan-cocled, with intake on the frontside
of the unit and extraction on the backside Allow at least 10cm
{4 inches) at front and back side of the unit for sufficient ven-
tilation,
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Front panel

L >

@ The Intelli-Power10 s powered on and off by a front panel
switch; an adjacent white LED lluminates when the unitis
powered,

: In n .

which mutes the input channel, depending cn the setling
of the Master MUTE/SELECT button [€]

®

>«
@ Each input channel has a 6-segment tricolour LED

bargraph meter which indicates the signal level in the
channel. The meter is calibrated in dBFS, where 0 dB
corresponds to digital clipping, The bottom 'Sig’ segment
illuminates at an input level of -48 dBFS. The top ‘Comp’
segmentilluminates when gain reduction in the channelis
being applied by the compressor,

@ Inputchannel AES LED(s). Each pairof inputchannels has
ared LED whichilluminates if those channels are selected
to be an AES-3 digital input pair,

@ @ ® ©® ©

Output Controls:

@

@® Each output channel has a "soft” button below its meter,
which performs either a Channel Select function FOR
THE INPUTS in conjuncticn with the menu system), or
mutes the cutput channel, depending on the setting of the
Master MUTE/SELECT button [S].

0 @ 7-segment bargraph metering is provided for each output
channel, the meters are similarto the input channel meters
[14], but the highest segment indicates operation of the
output channel limiter, and the bottom 'Sig’ LED illurmina-

D) tes when the output channel signal level is 48 dB below
the RMS limiter threshold.

1
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Rear panel

fio at thic lse 3 75 Q) <=110 Q impadance
5 Q AESId or S-PI
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The aptional rear panel Ethernet ports labeled "Pri* and
"Sec” allow the Intelli->E to be integrated into a Dante
ACE network,

Depending on  the chosen Dante  network
configuration, both ports will either act as an Ethernet
switch, allowing loop-thru connectivity with other
Dante devices on the same subnet, or will operate on
separate subnats allowing redundant connectivity with
the Dante network.

The rear panel Ethernet ports allow the Intelli-xC to be
connected to an Ethernet netwark, for remote control
via Intell-wWare, Two ports are provided to permit units
to be "daisy-chained”. There is also an Ethernet port on
the front panel for sase of temporary PC access when
the unitis installed in a rack.

A Neutrk PowerCON® 32A connector provides AC
Mains input

speakON speaker output conNNectors - Power outputs
are available simultaneously on a single 8-pole con-
nector and on two 4-pole connectors, The four-pole
connectors carry outputs for channels 182 and 354
respectively.

13



Wiring the unit
/ 9

14

The use of win-and-screen cable is recommended for both
inputs and outputs.

Inputs Outputs

Preferred wiring for both balanced and unbalanced sourcesis  Preferred wiring for both balanced and unbalanced
llustrated below: destinations isillustrated below:

Balanced Balanced

Balanced outputs : Intelli-X* inputs: Intelli-X* outputs: Balanced inputs (e.g. XLRs):

pin 1 = ground R pin 1 = ground pin 1 = ground pin 1 = ground

pin 2 = hot pin 2 = hot pin 2 = hot pin 2 = hot

pin 3 = cold pin 3 = cold pin 3 = cold pin 3 = cold
Unbalanced Unbalanced

Unbalanced outputs Iimtelll-X? Inputs: Intelll-)? outputs: Unbalanced Inputs
(e.g. phonos): pin 1= ground pin 1 = ground (e.g. phonos):
screen = ground pin 2= hot pin 2 = hot screen = ground
pin = hot pin 3 = cold pin 3 = cold pin = hot

14



Important note regarding presets creation

Input frontpanel operation:

OQutput frontpanel operation:

PEQ Comp Reating Delay Drv Adign

¥-Cnar

(=]

(=

Limitre

Local 0

15
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Using the Intelli-Power10

Powering up the unit

When the Intelli-Fower10 is powered on, the APEX logo is
displayed on the LCD screen while system initialisation and
internal diagnastic checks are being run, All front panel LEDs
are tested as part of these checks The Boot status page Is

displayed briefly, confirming the firmware version number.
All unit aperations and audio parameters are controlled throu-

gh the Intelli-Power10 menu system. This section describes
the various menus and submenus in wrmn.

After the boot-upis complete, the display shows the
Home Page:

Preset: Last recalled preset

The Home page is the menu "entry level’, and confirms
the names of the currently-loaded preset (which will be
those in use when the unit was last powered-downy.

To access the main menus, press the Enter button [2]
(the rotary encoder).

Entry to these menus is displayed in the form of icons,
illustrated below:

Audio Seﬂi'lgs Securty  About

Note that nat all the options in this menu (and others) are
visible simultanecusly. Use the = and < buttons [3] or the
rotary control [2] to move along the row: In all menus, the item
selected for access is indicated by a highlighted icon. It may
be selected by pressing the Enter button [2]

Prassing the BACK/HOME button [4] at any time will move the
display “back up” the menu cne level and a “long" press will
return the menu directly o the Home page. (The exception o
this is when softkeys have been enabled.

Selecting and adjusting parameters

When a list of items is displayed within a menu or submenu,
the rotary control is used to scroll through the items rapidly.
Each item is highlighted in turn. The highlighted item may
be selected for adjustment by pressing Enter, when a ‘scroll
symbol will appear next o the current setting. While this is
visible, the rotary control can be used to select an alternative

option, change the parameter value or tick/untick a checkbox,
asthe case may be.

Altering numeric values - a shortcut

The range of some parameters & considerable, and the
resolution of adjustment very small. so in some situations,
using the rotary control to enter a high parameter value directly
is quite laboricus. A shortcutdata entry method allows a much
fasterway of entering a known value:

1. Select the parameter o be adjusted so that itis highlighted.

2 Press and hold Enter (>2 sec).

3. This expands the parameter valug by inserting leading
zeroes as rfequired, and highlights the first available digit
position,

4 Use the rotary encoder to select a different digit position, if
required, and prass Enter again to select it

5. The rotary enoder may now be used to alter that digit alone.
Press Enter when the correct integer is showing,

6. Repeat steps 4 and 5 until the full value is entered.

7. Scroll to the right hand end of the number string, and press
Enter to complete the adjustment.

Editing text fields

Several menu displays include text fields which may be
renamed by the user. The field available for editing will be
highlighted, Press the Enter button again to highlight the first
character of the field. Press once more o enable character
editing. Note that & 'scroll’ symbol appears at the end of the
field. Use the rotary contral to alter the highlighted character.
The characters available are;

ABCDEFGHIJKLMNOPORSTUVWXYZ
abcdefghijkimnopgrstuveexyz0123456789_-+ . [1()

Note that the first character is a blank space. Use this o dslete
unwanted characters,

Each character in the fisld may be edited in turn, using the ro-
tary control to select the next. When complete, press BACK/
HOME to highlight the entire fisld,



The softkeys

The six keys around the LCD are "soft" keys - that is, they per-
form different actions depending on the current menu page
being displayed. Ingeneral only some of the softkeys are ena-
bled in each page, and some menu pages have no scftkey
functions,

In the descriptions of the menus which follow, availability of

softkey functions are indicated at the appropriate places by
the: use of the softkey symbol

Fn

If available, softkey functions are enabled by pressing
the Fn button [7]. This will open a screen overlay, which
will indicate the action that each of the softkeys now in
use will have,

Many of the overlays time-out after approx. 5 seconds if no
selection is made. Others remain in place, and requirg definite
input from the user.

Menu entry level softkeys - Locate and Lock functions

Some softkey functions are available from the menu entry le-
vel (le, when the six main menu icons are displayed):

@ - apens an overlay with the following options:

- Locate unit. This 1s a useful feature when using
multiple units with Intelli-Ware. Selecting Locate causes the
unit's icon on the Intelli-Wars screen to flash to allow immedi-
ate identification. All six softkeys on the front panel also flash.
The Locate function can be cancelled by pressing h.,

(A corresponding Locate function can be initiated from Intelli-
Ware)

- Lock/Unlock function. This is a useful safety
feature; pressing Lock/Unlock prohibits access to the Audio,
Settings or Security menus. A padlock symbol appears on the
icons for those menus. To unlock, press Fn, then Lock/Unlock
again o open the Unlocking the unitdata entry window

Enter Pin Code:

A 4-digit PIN needs to be entered 10 unlock the menus. Press
Enter to select the first digit position, and again, to allow digits
0 1o 9 to be entered with the rotary encoder, Press Enter when
the correct digit is showing. Note that the digit position reverts
to an asterisk. Using the rotary encoder, scroll to the remaining
digit positions, entering the correct digit each time. When all
four digits have been entered, press Apply h. The menug will
now be unlocked. Note the BACK/HOME button can be used
tocancel the PIN at any time,

The factory default PINis 1234, See "Security Menu' for details
of how to change the PIN.

17
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For full details on how to import presets from other
manufacturer's DSP  devices please visit the Apex
website (www.apex-audio.be) and download the latest
white-paper.

The Intelli-Power10 has 100 internal memoaries for sto-
ring Presets; 10 are pre-configured Factory Presets, and
the other 90 are denoted User Presets. The User Presets
are arranged into nine banks - called Categories - of ten.
A Preset is a complete set of unit parameters and
settings, including all audio parameters such as input
selection and level, equalisation, delay, input/output
routing, crossover configuration, limiter settings and so
on.

You can set up the Intelli-Power10 (e.g. for a particular
speaker make, model and configuration), and store the
settings in a User Preset so that they can be recalled
again for future use. You can also name each User
Preset and sort them into meaningful categories (for
example, by speaker manufacturer) to enable easy
access. Presets may be also be protected to prevent
inadverient overwriting,

0: Factory Presets
1: [User Presets]
2: [User Presets]
3: [User Presets]
4: [User Presets]

The Preset menu initially offers a choice of the Factory Presat
bank (Bank 0) or the nine User Presets banks (Banks 1 to
9). Only the first five banks can be displayad; use the Scroll
buttons hand | 1o see the others.

Factory Presets

(Zo - A Factory Preset may be recalled (loaded) by
pressing the Fn button from a Category list. This opens an
option window: Press Recall to load the Preset, or Recall &
Mute to recall it, but mute the outputs (for safety). The Factory
Preset Bank is empty inthe Intelli-Power10 at present.

User Presets

Use the rotary control to highlight one of the User Preset
Categories, press Enter to select it

Initially all User Preset memories are empty. (Once Presets have
been renamed by the uger (see below), the names appear in
the list instead.) Only the first five memories can be displayed,
use the Scroll button [2] to see the others. More details about
a Presat can be obtained by pressing the Enter button, which
confirms the Name and a Dascription.

Unnamed preset
Descr.:
New Preset description

Recalling a User Preset

- A User Preset may be recalled (loaded) by
pressing the Fn button from a Category list. This opens an
optionwindow: Press Recall to load the Praset, or RecallgMute
to recall it but mute the outputs (for safety).

Naming and saving a Preset

Naming a Preset before saving it is strongly recommended.
When an empty Preset is selected from a Category List, the
Name field (initially Unnamed Presat) is highlighted to indicate
that character editing may be performed. When complete,
press BACK/HOME to highlight the entirg fisld, and then tum
the rotary control o select the Description field; this may be
edited in exactly the same way.

After pressing BACK/HOME again, press the Fn button,
which will open an overlay. Press Save 1o store the
current unit parameters in the Preset memory, together
with the new Name and Description; altematively, select
Cancel
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Editing a Preset

A Preset may be overwritten and/or renamed once it has been
created. To edit a Preset, select it from its Category list and
open its Preset Details screen. Press the Fn button and select
Edit from the overlay (the ENABLE button). The Name field will
now be highlighted forediting.

Note that it is not necessary to actually have a Preset loaded
into the unit 1o edit its Name and Description. However, when
the edited fields are saved, the current unit parameters will be
stored, which will overwrite the previous contents of the Preset
memory location.

The Audio Menu is where all audio parameaters and settings
are adjusted. The top page of the Audio Menu offers five
further submenus:

-0 -

Local 1O Routing Gain Delay PEQ Meters

Fress Enter [0 selectone of the submenus.

. Local I/0O submenu

The Local /0 submenu is concerned with the physical inputs
of the unit. The initial selection of Local 11O will display the
settings for Inputs A and B, The MUTE/ENABLE buttons for
these inputs will illuminate green to confirm which channels’
settings are being digplayed. Note that /O settings are abways
displayed for channels in pairs; the corresponding settings for
other pairs of input or output channels may be displayed by
pressing the MUTE/ENABLE button for either channel of the
pair.

Clearing a Preset

To erase the contents of a Presat memaory, select the Preset
from its Category list and open its Preset Detalls screan. Press
the Fn button and select Erase from the overlay (the Fn button),
Naming User Preset Categories

Preset Categories may be ranamed using Intelli-Ware. Itis not

possible to perform this function from the unit's front panel,
Flease ses the Intelli-Ware's Help files for more information.

Input settings

LabelA:

Label B: Input B
Mode:  Analog  MaxAnaloginlevel: 21dBu

{0 Inputs XLR pin-1 It (] SRC Bypass

he screen shows the connectivity parameters for the selected
inputchannels. Use the rotary control ta move the highlight up
and down the list

Label A and B - this lets you changs the name of the input
channels {from Input A, etc) to cne of your chaice, to suit
the application in which the Intelli-Power10 is being used.

Mode —set to Analog when using in an analogue system, and
AES3 or DANTE with a digital system. The channel's input A-D
convertaris in circuit when Analog is selected, and bypassed
in the AES3 setting. Bacause the AES digital format carries two
audio channels (as multiplexed data), selection of AES3 puts
baoth input channels A and B into the digital mode, though
only Input A's physical connector is used. The same principle
applies winputChannels C and D. When AES31s selected, the
DIG LED will illuminate if a valid AES3 signal is detected, and
blink if not,

SRC bypass — the Intelli-Power10 digital inputs are able ©
acceptinputsample rates of between 32 and 192 kHz. Sample
Rate Converters (SRCs) are fitted to each input to convert
the sample rate of the incoming audio to that of the internal
processing. The default is for the SRCs to be in circuit but
depending on the synchronisation topology being employed,
they may be bypassad by ticking the checkbox.

19
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Routing submenu

The Intelli-Power 10 output has a cc nding Routing Matrix
screen, showing which inputs are routed to outputs.

When Routing is selected from the Audio submenu, the screen
initially shows the routing for all outputs.

A :] c D
B BB v
H N a

OuUT 3/4

In this example the Intelli-Power10 isloaded with a 2 x 2-way con-
figurati utput one and two are fed from input A where input B

feeds outputs 3and 4

\\

= Gain

Two gain parameters are available for adjustment. Use the
rotary control to move the highlight o the parameter required

Gain - this sets the gain of the input stage for the selected In-
put Channel (post the ADC in the case of analogue inputs)
The default gain setting is O dB, but can be set to any value
from-80dBto+15dB, in 0.1 dBincrements,

Polarity - this allows polarity inversion to be applied to the
selected Input Channel. The options are Normal and
Inverted.

m Delay

Each Input Channel of the Intelli-Power 10 may have up ©
165 of delay would narmally be for time-
aligning ¢ way speakers ase refer
e ifcatio Jrrect
y control to highlight the parameter re-
& for adjustment

quire

0 smpl
Distance: 0.00 m 0.00 ft
Common Temp: 21.0 °C 69.8 °F
Common Humidity: 500 %
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Enable - either the ENABLE or Enter buttons may be pres-
sed toinsertdelay in the channel. Default is Off

Duration - allows the delay to be setin units of time, from O 1o
158 inmicrosecond increments. Note that the durationis also
displayed as the equivalent number of digital samples.

Distance - this provides an alternative method of setting the
delay time, in units of distance, from 0 to 500 m. Entering a
delay in terms of distance will usually be more convenient in
realworld situations. Note that distance may also be entered
infeet, if preferred. (The Internal distance-to-time conversion is
based on a nominal speed of sound of 3465 m/s (1,137 ft/s),
at 20°C and 50% RH)

Temperature — the speed of sound varies with temperature,
this parameter is used in conjunction with Distance. The
ambient temperature may be entered here to obtain a more
accurate delay value The range avallable is -20 °C 10 +50°C
and the default value is +21 °C. Note that the temperature may
beentered in "Fif preferred, and that the value used applies t©
all delay settings throughout the unit,

Humidity - the speed of sound also varies with the relative
humidity (RH) of the air. If known, the RH may be entered here,
as a percentage from 0% to 100%, with a default value of 50%
Note that the humidity value used applies to all delay seftings
throughout the unit,

Parametric EQ

Aswell asa graphic equaliser, each Input Channel of the Intelli-
Fower10 Is equipped with a 12-band parametric equaliser.
This provides an alternative and more accurate method of
tailoring the frequency response, and is useful when running
RTA analysis during room tuning

Toenable the entire Parametric EQ section, press the Enable
button. Defaultis Off.

No En Type Gain(dB) Q

1 8 31.0 0.0 250
2 [ Bel-Sym 63.0 0.0 2,50
3 [ Bel-Sym 125.0 0.0 250
4 [ Bell-Sym 200.0 0.0 250

All 12 filters offer an identical selection of filter types (see
below). The filter parameters are displayed across three screen
pages press the h and i buttons to scroll between pages. For
each filter, five EQ parameters are available for adjustment

Enable - the Enter bution enables the filter. Default is Off.

Type- 16different algorithms are available foreach filter. The
defaultis Ball-Sym. The full listis:

TYPE DISPLAYED AS: GAIN? Q?
Bell-Symmetrical Bell-Sym v v
Bell-Asymmetrical Bell-Asym v v
Motch Nofch ¥
Low-Shelving 6dB/oct Low-Shelv 6dB/o v
Low-Shelving 12dB/oct | Low-Shelv 12dBlo | v
High-Shelving 6dBfoct High-Shelv 6dBlo v
High-Shelving 12dB/oct | High-Shelv 12dBflo | v

All-Pass 80° All-Pass 80

All-Pass 180° All-Pass 180 v
Low-Pass 6dB/oct L-Pass 6dB/o

Low-Pass 12dBloct L-Pass 12dBlo

Low-Pass Vari-Q 12dBloct) L-Pass VarQ 12dBlo v
High-Pass 6dBfoct H-Pass 6dB/o

High-Pass 12dB/oct H-Pass 12dBlo

High-Pass Vari-Q 12dBloc{ H-Pass VarQ 12dB/o v
Band-Pass Band-Pass v

The Gain? And Q7 columns In the table show whether thess
two parameters are fixed or available for adjustment (&) for
each filter type. Note that Type is a common parameter which
applies to all 12 filters making up the equaliser
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Frequency — this shows the centre frequency of the selected

filtier. It may be varied over the range 10 Hz to 22 kHz, in 0.1 ﬁ Meters submenu
Hz increments. Note that the default values are at standard
frequencies:

This submenu lets you configure how the Intelli-Power 10 bar-
graph meters function.

1 N5Hz
63
g :;50:: Fallback time:
k Hold: 1
4 200 Hz Peak Hold 0 5
5 315Hz
6 500 Hz
7 800 Hz
8 1.25kH
9 2 kHz ‘ Fallback time - default setting is Normal, but may be set (o
10 315 kHz Fast if preferred, this may make monitoring of rapid, fransient
1 6.3 kHz signals easier.
: o Peak Hold - may be set at any time between 02sand 3s.
The defaultis 28

Gain - for filter types allowing adjustable gain, this parameter
allows between -40 and +15 dB of gain (o be applied at the
selected frequency.

Q - for filter types allowing adjustable Q, the bandwidth of the
filter section may be setin the range from Q = 0.1 (wide) to 48
(a very narrow notch).

IMPORTANT NOTE: The input section's parametric equali-
ser function is not available if the Intelli-Power 10 sample rate is
setto 1764 kHz or 192 kHz
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Menu

e Settings Menu is where some of the unit's basic cperatin
conditions are defined, unl & these have Je~r| &
the menu will only rarely nesc S
of the Settings Menu offers Tuur further submenus:

KA
e

Name Network Clock LCD

Press Enter to selectone of the submenus.

n Name submenu

In the name submenu you can give each Intelli-Power10
an individu =]
That becomes handy when operating several Intelli-Power10
devices in larger setups.

Network submenu
| Network . 12 )

I | Enable SNM

IP Addr: 000 .000 .000 .000

IP Mask: 000 .000 .000 .000

Gateway: 000 .000 .000 .000

MAC Addr: 00-00-00-00-00-00

Quick setuptip:

« Connect a standard network cable betwesn your FC
and any of the ethernet ports of the Intelli-Power10

-+ Set your PC to DHCP and the Intelli-Device in Enable
Auto P

+ Itean take a minute or maore before the connection is es-
tablished, this is normal

- If the white Led lights up, you are connected.

Note: If your PC network portis set to static IPwhile
the Intelli-Device is in Auto IP mode, the Intelli-De-
vice will still pop-up in Intelli-ware on your PC but
all the icons and controls will be greyed out.

When the Intelli-Power10is being used with Apex's Intelli-Ware
softwara application, an Ethemet network connection needs
to be established between the computer running Intelli-ware
and the unit(s). Network settings are available in this submenu
D& set up cormectly

> done 1s enable the AUTO-
[l then be assigned to the Intelli-<3
: s and will take a few
>d then scroll to the 1P
Address and SubNet fields to enter the correct settings

If using external network management and monitoring
applications then ensure that the SMNP box {Simple
Network Management Protocol) is enabled. Generally
such applications are only used for managing very
large networks {in large corporations etc.) but can be
implemented in fixed installations such a broadcast
facilities or large AV installations.

help to permit this connec nor. (8]
In most -
IP Do,

{note [hr‘i[ I

After any changes have been made in the Network submenu,
exiting the page (by p g BACK/HOME) first apens 4
screen requesting confirmation that the changes are 10 be
applied

Apply your changes?

Cancel




Providing that the network is properly configured, Intelli-Ware
is capable of automatically detecting and controlling any
Intelli-}3 device connected to the network. Please refer to the
Intelli-ware documentation for more details on controlling the
Intelli-}3 remotely.

Configuring simple 1P networks is something that maost
system engineers would be aware of. BExplaining the details
of IP netwaorking is therefore outside the scope of this manual,
however we believe some salient points do require further
clarification.

IP Addresses

All computers, whether they are Windows, Linux or Mac OS
based and most network-based devices such as the Intelli-x3
obtainan IP address by the following means:

- |f a static IP address has been assigned o the computer
or device, then that IP address must always be used.
Static IP addresses are fixed and do not change. This
is useful when installing Intelli-=¢ devices into fixed
installations whereby all networked audic equipment
has been assigned a unique and unchanging 1P address.
This is very useful for network management

- If the device or computer is get to automatic mode
(whereby no static IP address has been defined) then &
unigue IPaddresswill be used; however this address may
vary every time the device is connected 10 the network.
If & DHCP server 1s avallable on the network then the
Intelli-x3 will use the IP address provided by it. If no DHCP
serveris available, the Intelli-¢ will automatically select a
unigque and unused IP address in the range 169.254.1.0
0 169.254 254 255 (this is referred to as Auta-1P).

Further information

In most applications, commurication between the Intelli-»}®
and Intelli-Ware software will not require any configuration
and will effectively work ‘out of the box. However, when the
Intelli-Power101s used in more network critical environments
(eq. broadcast or AV installations) some additional network
settings may be required and the information provided below
may be of interest.

The communication protocol used by the Intell-Power10 is
UDP/IP based. It is based on Unicast communications (point-
to-point) for the remote control of properties (e.g, modifying
an input gain or the frequency of a filter) and Multicast
(point-to-multipoint) for  auto-discovery of devices and
property changes (such as driving meters within Intelli-Ware).
Multicasting is preferred over broadcasting as itis more suited
for network bandwidth control.

Note that if IGMP (Internet Group Multicast Protocol) features
are available in your access point/switch then do enable them,
By default, most network equipment will flood multicast traffic
to all hosts which is not ideal. If your access point or switch
also has IGMP snooping capability then enable this too.

The default cutgoing multicast address is: 239.128.0

By defauli, the Intelli-Power 10uses the fallowing UDP ports:

50000 | Outgoing multicast notifications
Incoming multicast nofifications (currently unused)
Incoming unicast commands

Ethernet cables

Nowadays, computers and network devices automatically
detect the type of connecticn (irespective of whether straight
or crossover Ethernet cabling is used). The Intelli-Power10
pperates in the same manner, hence there is no need to worry
about cable wiring when outin the fisld,

Remember that there are limits to Ethemet cable length
between two devices and thisis 100 meters.

Going wireless

Using wireless networks may be challenging, but the key 10
success is 1o use good quality rugged wireless access paints
and configure them correctly.

Configuring an access paint is not that difficult. There is no
requirement to install any software as the computers web
browser is sufficient (all access points have a buil-in web-
server). Just type in the IP address of your access point into
yourweb browser and you'll be able to configure the device.

Itis good practice to keep the firmware of your access paint
up-to-date, as you would do with your Intell-Power10. Some
required features may not be present at the time of purchase
but may have been added by now.

Recent Wi-Fi™ certified access points have basic Quality of
Service (QoS) features called Wi-F Multimedia (WMM). These
features are not always enabled by default. For reliable and fast
communication between the Intelli-Power 10 and Intelli-Ware
this function should be enabled.

In some applications, there may be a requirement to boost the
signal level of both the access point and computer (outdoor
stadium shows for example). External boosters are available
but these will require that the original antenna of the access
pointor computer be removed (this has a bearing on the type
of access point chasen), Note: always check local regulations
concerming maximum permitted wireless signal power before
up-rating your equipment.

If you wish to purchase a wireless access point, do consult
with your Apex distributor or with Apex directly to obtain a list
of recommended units.
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Clock submenu

The Intelli-Power10 maintaing an event log which may be
viewed on the front panel LCD or by using Intelli-Ware; the
Clock submenu allows the internal clock/calendar to be set
correctly so that the log details are accurate.

Sd LCD submenu

L

Twa parameters in this menu lets you adjust the LCD screen
brightness and contrats to suityourworking environment. The
scaling is as a percentage of the maximum brightness, and the
default value is 100%

|

08 /APR/ 2011
12 07 A

LCD Backlight:
LCD Contrast

Date: This field is selected by default to change the date,
press Enter to highlight the day only, then either press Enter
again to modify the day with the rotary control, or use the rotary
control to select either the month or the year. These can then
be altered in the same manner,

Time: Clock setting is perfarmed in the same manner, from
the initial submenu select the Time: field with the rotary control
and then press Enter 10 select the hour,

It may be advisable to "lock” cenain features of the Intell-
Power10, to prevent inadvertent system changes from being
made at a critical time. The Security menu offers three options,
the default state being that all restrictions are ‘off, and thus all
the relevant changes can be made if wished.

Allow Mute

A tick in the checkbox means that the operating function is
enabled. Press Enter to remove/replace the tick. The three
options are,

Allow mute - when unticked, the front panel MUTE buttons
become incperative, This applies o both the Input channels
and Output channels. Note that it is the MUTE buttons
themselves that are disabled - active channels cannot be
inadvertently muted, and channels already muted cannot
become unmuted.

Allow preset recall — when unticked, it s not possible ©
load a different Preset .

Security menu softkeys - Locking and PIN change

From the Security menu, the following softkey functions are
avallable:

- Change Password. This allows the Password
needed forthe Unlock function to be changed from the factory
default code (1234). Pressing Change Password opens the
Modifying the Password dislogue box

Enter Password

Scroll to the Old Password Code field, and enter the current
Password using the same method as forentering the Password
tounlock (You cannotchange the Password withoutknowing
the current one). Then scroll to the New Password fisld and
enter the new Password. Press Apply o make the change or
BACK/HOME to Cancel,

- Lock/Unlock function. This is the same Lock
function that is available from the main menu top page.
Selecting Lock prohibits access o the Audio, Settings or
Security menus. Because the Security menu 1S no longer
accessible once Lock is applied, unlocking must be selected
from the main menu top page.



Owner: Apex
Device ID: 00000000137052bd
Firmware: 1.3.00

Intem temp: 303 °C 86.0 °F
Battery: OK

This page gives permanent information regarding the
particular Intell-Power10 unit. None of the fields are madifiable.
The data displayed consists of:

Owner: this will narmally be 'Apex
Device ID: unique hardware identification number
Firmware: the: version number of the internal software

Press « toopen the second page.

Internal temp: the unit's internal temperature in both °C and °F.
Battery: state of theinternal device which maintains the  non-
volatile memories when the unitis off.

Press « to return to page 1.

08.04.2011

12:59:19  Device unlocked
08.04.2011  12:58:15  Device locked
08.04.2011  09:30:3¢  Audio Sync changed: INTERNAL
08.04.2011  09:30:28  Device started
08.04.2011  09:30:26  Preset changed: Default preset

The last 25 events of the internal event log are displayed
across five pages. Use the h and 1 buttons to scroll between
the pages.

The log lists the events in reverse order, with the most recent
at the top of Page 1. The date and time of the event appears
against a brief description.
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Electrical specifications
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“=..___ Technical specifications

~
Balanced line level input
Connectors 3-pin XLR (software switch-able between analog and AES-3)
Type electronically balanced
Impedance >10 kohms balanced
Common mode rejection >90dB
Maxinput level 21 or 24 dBu software selectable, balanced, 1% THD+N
Frequency response 20Hz-20kHz +05dB
THD+N less than 0,0068%, +4 dBu, 20 Hz- 20 kHz 22 kHz BW
Dynamic range 120dB, 20 Hz to 20 kHz, un-weighted at +21 dBu headrocom settings
Crosstalk >80 dB
AD conversion 24-bit, sigma-delta
AES-3 inputs
Connector 3-pin XLR (software switch-able between analog and AES-3)
Type transformer isolated
Impedance 110 ohmsg balanced
Supported formats AES-3 and SPDIF up to 24-bit
Supported sample rates 3210 192kHz
Dante Pri / Sec AoE network
Connector. Neutrik EtherCon
Power Outputs
Connectors; 2% NL4 + 1% NL8
Power stage: class D, DC coupled driven from DAC
Ouptut power, 60Hz burstrms 1/3 12dB crestfactor
4x 2500W, 2ohm
Ay 2600W, 4o0hm
A% 1600w, 8ohm
Frequency response: 20Hz-20kHz +02 dB load independant
Phase response; +6 deg 20hz - 20kHz
THD+N: 0.005%, -20 dBu, 20Hz- 20 kHz, 22 kHz BW
Dynamic range: 123 dB, 20 Hz o 20kHz, un-weighted
Crosstalk: >80 dB
DA conversion resolution: 24-bit, DC coupled
& 4
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Digital processing

Sample rate:
Internal processing:
Input

Network remote control
Built-in Ethernet switch
Connectors
Protocol

Mains
Connector:

Voltage:
Fower consumption:

44,1 kHz 48 kHz, 88,2 kHz, 96 kHz, 176,4 kHz or 192 kHz selectable
32-bit floating point
4in

|EEE 802.3 10Base-T/100 Base-TX
3 x Neutrik EtherCon, Auto MDI-MDIX
Proprietary UDP/P based, SNMP

Neutrik PowerCon
240Vac/50hz or 120Vac/60hz (internally switchable),
<3500VA

N

Gain
Polarity

Delay
Duration
Distance
Temperature
Relative humidity

GEQ

PEQ
Bands
Filter types

Freguency
Gain
Q

Input channels functions

8010 +15dB 0,1 dB steps

normal / inverted

0to 1500 ms, sample rate depend steps,

Oto&00m

-201050°C (-4 10 122°F), 0 1° steps

0to 100%, 0,1% steps

(Temperature and relative humidity are common to all delays)

30-band ISO centred, +~15dB,
proportional-Q or constant-Q mode selectable

12

Ball-Symmetrical, Bell-Asymmetrical, Notch, Low-Shelving 6dB/

oct

Low-Shelving 12 dB/oct, High-Shelving € dB/oct,

High-Shelving 12 dB/oct, All-Pass 907, All-Pass 1807,

High-Pass 6 dB/oct High-Pass 12 dB/oct, High-Pass Var-Q 12 dBloct
Low-Pass 6 dB/oct, Low-Pass 12 dB/oct, Low-Pass Var-Q 12 dB/oct
Band-Pass

10Hz o 22 kHz, 0,1 Hz steps

-40 10 +15dB 0.1 dB steps (when applicable)

0.1 t0 48, 0,01steps (when applicable)
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Compressor
Threshold
Ratio
Knee
Altack time
Release time

Side-chainmode

Make-up gain

Gain

Routing

Delay
Duration
Distance
Temperature

Relative humidity

Driver alignment
Duration
Distance

PEQ
Bands

Filter types

Frequency
Gain
Q

High-pass and low-pass crossover

Filter types

Frequency

FIR filters
At 48 kHz
ALSB kHz

Gain
Polarity

Limiter
Type
RMS threshald
Peak threshold
RMS attack
Peak attack
Release

-80t0 0dBfs 0.1 dB steps

1:1 10 2011, 0.1 steps

hard or soft

0510 100ms 0,1 ms steps
5105000 mg 0,1 mssteps

flat high-pass or band-pass mode
Oto+10dB 0.1 dBsteps

Mix matrix functions
-80t0+15dB 0 1dBsteps

enabled/disabled

Outputchannels functions

010 1500 ms sample rate depand steps,

010600m

2010 580°C (-4t0 122°F), 0. 1°steps

010 100%, 0,1% steps

(Temperature and relative humidity are comman to all delays)

0 to 30 ms, sample rate depand steps,
0to1029cm, 0,1 cm steps
(temperature and relative humidity independent)

12

Bell-Symmetrical, Ball-Asymmetrical Notch, Low-Shelving 6 dB/oct,

Low-Shelving 12 dB/oct, High-Shelving 6 dB/oct,

High-Shelving 12 dBfoct, All-Pass 907, All-Pass 1807,

High-Pass 6 dB/oct, High-Pass 12 dB/oct, High-Pass van-Q 12 dBloct,
Low-Pass 6dB/oct, Low-Pass 12 dBfoct Low-Pass Var-Q 12

dB/oct, Band-Fass

10 Hz 1o 22 kHz 0,1 Hz steps

-40 0 +15dB 0. 1dB steps (when applicable)

01 to 48, 0,01 steps (when applicable)

Butterworth 6 to 48 dBloctave, BdB steps
Linkwitz-Riley 12 to 48 dBloctave, 12 dB steps
Bessel 12 to 48 dB/octave, BdB steps

10Hz o 20kHz 0,1 Hz steps

5x 1024 tapsor 8x 512 taps,
3x 1024 taps or 7 x 512 taps; 3584 taps total maximum

-8010+15dB 0.1 dBsteps

normal /inverted

Dual-stage, RMS + Peak limiter

-80 to 0 dBfs {ordBu eguivalent), 0,1 dB steps
-80 to 0dBfs (ordBu equivalent), 0,1 dB steps
0110100 ms 0.1 ms steps

0ms

5105000 ms, G1 ms steps




Operating
Temperature:

Relative humidity:

Storage
Temperature:

0t0B0°C (3210 122 °F)
10 1o 80%, non-condensing

-20t070°C (-2010 158 °F)
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Dimensions Weight
Unit Unit (Nett),, Inteli-PFoweri0  155kg
Width 483 mm (19-inch)
Height 436 mm (1,75 Inch- 1U) Gross (Shipping)  Intelli-Power10  17kg
Depth 450 mm
Package
Width 590 mm
Height 126 mm
Depth BEOmm
-

In the interest of product development, Apex reserves the right to madify orimprove specifications of this product at any time, without prior
notice and without any obligation to change or update equipment already delivered.

A




L — ' - Limited warranty
\ ___-‘—____—-s—

Limited warranty

GIVA BVBA ("Apex’) warrants you, the original purchaser, or any party that purchases the de-
vice from you, that its products are free from defects in material and workmanship under nor-
mal use for a period of two (2) years from the date of onginal purchase. The date of purchase
is the date which appears on the first invoice or any other proof of purchase provided by an
Apex approved dealer.

Subject to the conditions and limitations set forth below, Apex will, at its discretion, either re-
pair or replace any part of its products that prove to be defective, provided that the product is
returned with proof of purchase, shipping prepaid, to an authorised Apex approved service
facility.

Warranty cover of any repairs will only extend to the end of the original warranty period.

We will be happy to provide you with a list of authorised dealers to whom you can refurn the
defective unit or who will give you a retumns note 1o enable you to send the unit to the factory.

Service tum-around time will be as fast as reasonably possible. If you are not satishied with the
repair, contact Apex.

Exclusions and limitations

This limited warranty covers only repair or replacement for defective products manufactured
by Apex. Apex is not liable for, and does not cover under warranty, any loss of data or any
costs associated with determining the source of system problems or removing, servicing or
installing Apex products. This warranty excludes 3rd party software, connected equipment or
stored data. Apex does not warrant that the operation of the product will be uninterrupted or
error-free. In the event of a claim, Apex's sole obligation shall be replacement of the hardware,

This limited warranty does not cover,

(1) any damage to this product that results from improper installation, accident, abuse,
misuse, natural disaster, insufficient or excessive electrical supply, abnormal
mechanical or environmental conditions or other extemnal causes;

{2} any damage caused by operating the product outside the permitted or intended
uses described by Apex;

(3) any damage caused by any unauthorized disassembly, repair, or modifcation;

{4) consumable parts, such as batteries;

(6) any cosmetic damage.

Apex is not liable for consequential damages.

This limited warranty also does not apply to any product on which the original identification
information (including serial number) has been altered, obliterated or removed or any product
that has not been handled or packaged cormrectly.

Warranty services will be fumished only if the product is accompanied by a copy of the origi-
nal retail dealer's invoice.

Warranty claims other than those indicated above are expressly excluded.
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Intelli-Ware control software

Home Screen

%l

e

m www.Apex-audio.be.

Menu Bar
» File > Add virtual device. [1c : tof all vir - Edit > Copy device. |
« Edit > Copy Channelin. T

« File >Open preset. Fr i den
tored on t out » Edit > Copy Channel out.

- File >Quit. T ted d
- Edit > Copy xxx 1

« Edit > Paste xxx |
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- View > Panes > Log. |

- View > Statué bar.

. View > Full screen. 10

« Help > About Intelli-Ware.

Selector Bar

Distput I Ot | [Ctpat 1)

a
3
o
-

« Tools > Firmware manager. From his i

-

rbar, all the connected devices are shown along

hat can be selected from the file menu.

an contain all of the Intelll family devices: IntellE

[¥2-Z and [X-Notch.
He done by a mouse click and the selecied

v UD In the overview screern.

=

Aright click on a devic
a second window w
functions:

- Locate
the frontpanel ic
-Copyar
device's ¢

Add virtual device Intelli-X* 26

Remove Device Intelli-X* 48
Laeate Intelli-X* 48
Intelli-Z*

Copy Complete signal flow
Paste

Intelli-P* 10

3 Notch Y44
N2/ ==

Local If0

34



35

Preset Menu
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Ganging Menu

Device

L)

Default

sl HHEE EEEE

PECEE DrOGEEsn
IEEE] ==

Device
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@ Settings Menu

Clicking on the se

s T e
3 [Ne 28

The net
current ne

g Intelli-Powerl0 |

=) oo

(1]

D 2B 2 B B

GEQ

Modeal: Apex Intelli-#? 10

Firmware: 2.4.0.0

il temp.: 388°C 10LB°F

Ba

PEQ Comg Moty Delay Dre Align

Audio sync
oo D0-50-C2-03-96-06

ifig: Automatic —
o Priority list

anclary. W.

internal

IP address: 169.254.244.17

L mask: 255255.0.0

about
e inforr

In the Audio
tings are |
from 441 |
The IP10cs
ditferent cl
tch autor

clock source is mi

maximum D
default value is

Defaultis internal €




Security Menu

Clicking on tt
open the security ov

dow,

& security icon wi
rvie

oo L

The security menu from the device s splitinto
two main areas, each with its own password
device security =l preset security

Devies secuity

Owner

Preset
| = My preset bank

2x Wedge Apen
{empty]

lemiptyl
lempry]
lempry]
lemptyl
lempiy]
lempay]
{empty]

lempty}
 User Presets 1
 User Presets 3

# User Presets 9

"

nnneEDDonn

BB DD DD DD

Lad b all all all ol - -] -] ]

Device security here you can lock, un-
lock or hide global functions of the
through all of the presets
Clicking on the Edit bo
the Device Security win ord,
ter entering the device password (defau
blank).

~

Change password: cpens a dia
where you can change the device pass-

word

Front panel and settings: 2o o
allow or lock global settings for all p

Preset library: recall overwrite and erase
permissions are set herg

Click on OK 10 return to the over

dow.
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Clicking on the preset edit
Box will bring you to the Pre-
set Security window, after
entering the preset password
(default = blank).

4
Reset all: removes all lock or hide functions
(greenicons)
All read only: all parameters are set to Read Only
(orange icons)
All Hidden: all parameters are set 1o Hidden (red
icons)

A

Every parameter from
gach in- and output
gan be set individual
10 the three stages of
securty: Free, Read
Only or Hidden

Change password: cpens a dizlog box
where you can change the presst pass-
word (default = blank].

Note: each preset can have its own pass-
word!

intelli-Powert0 | |
T . .

For each in-and output channel there s a master se-
curity function. Clicking on ane of the three icons will
set all the parameters of that channel to the desired
status.

Note: since the IP-10 has only four outputs,
channels 5 to 8 have no function.




Editing presets

@ Local I/O

—_—
(] wnelii-wiare

> i
File | B View Todls

Outputs: e
\ 'l
Here v |I
Note: all the parameters from the signal flow can
be different for each preset!

Inputs: Ner

4
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Environment

\ _~— ,

Environment ==1(irg-

Note: in- and output delay have identical windows.




i
T

L

i Graphic EQ
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T Parametric EQ
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Input PEQ: In A (Input




Input PEQ: In A (Input A)

-36t0 +18 v

|

From the options menu, you can select

“Viewing options " fromwhere you can selectwhat
functions have o be included in the total view of
the selected channel.

The vertical scale range has three different pre-
sets.

Input PEQ: In A (Input A)

EENQ

-
[ |

=10

~

From the options menu, you can select

“Viewing groups’ from where you can select what
channels hiave to be includad in the total view of
the selected channal

p

L

Note: aright click in any part of the window
gives acces to the copy/paste function of
the selected channels parametric EQ.
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Slde chaln - this
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Threshold - (s
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Stereo Operation:

It 1S important t© note that when ganging several input channels ogether, the compressar detection circuits of these
channels are linked. Thus, when using the compressor an stereo channels, it is very important t© gang left and right
channels in order 1o prevent the stereo image from shifting. When working with separate subwacfers or a centre feed, itis
advisable not ta gang these channels with the left and rights channels as this may lead to unexpected results

AS Opposed towhat many compressors do, the ganged channels are not summed before the detection circult Instead, it
is the highest detected signal that triggers the compression. This implementation gives far better results.

Note: a right click in any part of the window
gives acces to the copy/paste function of the
selected channels compressor.

Routing

Routing: opens a window where you can route the four in-
put channels to the four amplifier outputs.

Note: the routing window can change depending on the
amplifier lay-out. In the example below, the chosen lay-
out is 4x1-way.

T
To select a routing-path, double click on any of the grey check
boxes. Agreencheck box confirms the patch.
Inthisexample, Input Ais routed toamp channels1 & 2, and input
Cisrouted to ampchannels 3 & 4.

46



47

H Driver alignment

In addition to the delay inserted with the delay parameter,
gach Output Channel may also have an additional delay
added. This Driver Alignment delay is included to time-
align individual drivers within a cabinet (especially useful for
custom designed cabs).

EEEEEEZE T
ooooi2d onts] ool
EDosEGEDs
Faols | onz] o002 e

Enable - The ENABLE butions may be checked to ingert
driver alignmentdelay in the channel. Default is Off,

Values can be entered in either milliseconds, centimeters or
inches.

Richt click opens the copy/paste field for thatchannel.




.x Crossover

.

Filkes typer

Enable - chieck this box

Frequency - the turn-over fregquer

|LESTEHONE [TC
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Fram the options menu, you can select

Viewing options” where you can select what
functions have to be included in the total view of
the selected channel

The vertical scale range has four different presets

From the cptions menu, you can select

View groups " whiere you can select what output

channgls have to be included in the view,




Limitter

GR Outpst  RMS stage
a8 dBts

Peak
Limit

Peak stage

Limitter:
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H
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